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24 FILLABLE PDF FORMS 

Can't find it? Something missing? Instructions not clear? Email manuals@affinityconsulting.com.  

DRAFTING THE BACKGROUND FORM  

You first need to create the background form by either (1 creating it in a program like Microsoft Word or Publisher 
and saving it as a PDF, or (2) scanning it and saving it as a PDF. 

You will get a much cleaner and crisper quality document if it is re-created electronically in Word or Publisher and 
then you print/save it as a PDF. 

Once you have the underlying document converted to PDF, you will be ready to add the form fields in Adobe 
Acrobat. 

RUN FORM FIELD RECOGNITION  

Acrobat XI  

1. Click Tools button  Forms  Create. 

2. In the next dialog, choose Use an existing file or Scan a paper form  Next. 

3. If you choose "Use an existing file", the next dialog will ask you whether you want to use the current 
document or import a file. Choose Use current document  Next. 

4. Your form should now be fillable. 

5. This process will find most text fields on your form. If it doesn't you can add fields yourself. 

6. Once your form has been "recognized," click the Preview button to see how it looks and test it. To go back 
to edit mode, just click the Edit Layout button. 

Acrobat DC  

Open the form you want to make fillable and open the Prepare Form tool, then click on the Start button. That's 
it. Once your form has been "recognized," click the Preview button to see how it looks and test it. To go back to 
edit mode, just click the Edit Layout button. 

CLEAN UP THE FORM  

Fix Check Boxes  

The form wizard will locate check boxes on a form and make them fields. However, they are usually set up as 
separate fields which means you can check them all at once. That may be fine in some cases, but other times the 
options are mutually exclusive. For example, if you had a section of your form that looks like the following, you 
wouldn’t want users to have the option of checking both boxes: 
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FIGURE 24-1 

In the example above, the foregoing boxes were recognized by the form wizard as separate check boxes so the 
user would be able to check both of them. To eliminate this as a possibility: 

1. Remove the Existing Client field by clicking on it, then hitting your delete key. 

2. First, zoom in so you can better see what you’re doing. Double click the New Client field to get to its 
properties. 

3. Click on the Options tab and switch the Check Box Style from square (unless you like that) to Check; and 
change the Export Value from "on" to "True." 

 
FIGURE 24-2 

4. Under the Appearance tab, change the Border Color and Fill Color to "no color." 

 
FIGURE 24-3 
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5. Click the Close button at the bottom. 

6. Next, change the field dimensions so it evenly overlaps the borders of the checkbox. It would go from this: 

 
FIGURE 24-4 

To this: 

 
FIGURE 24-5 

7. Now click on the field you just modified and hit Ctrl + C (copy) then Ctrl + V (paste). Somewhere on the 
screen, a duplicate of the New Client field will appear. Drag it over the Existing Client checkbox. 

8. Double click the 2nd field to get to the Properties dialog. Click the Options tab and change the Export 
Value to false. 

9. Now Click the Preview button at the top left corner of the screen and test the boxes to make sure they’re 
mutually exclusive. 

Fix Tab Order  

The Tab Order is the sequence in which your cursor moves from field to field when you hit the tab key on your 
keyboard. Manually adding fields like we did in the preceding step can mess this up. In order to fix t in Acrobat XI: 

1. First click the Forms menu  Edit Fields  Show Tab Numbers. 

 
FIGURE 24-6 
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2. Click OK. On the left side of your screen, the fields appear in the tab order. If you want to change it, just 
drag a field to another location from top to bottom and you’ll see that its tab number will change 
appropriately. 

 
FIGURE 24-7 

In Acrobat DC: 

1. Expand the Tools Pane. 

2. Drag and drop the fields to change the tab order. 

 
FIGURE 24-8 
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Format Fields Properly  

Acrobat will not guess exactly how you want things formatted. Scan your form and if you see a field that needs to 
have specific formatting, double click it, click the Format tab and make the appropriate adjustment. 

 
FIGURE 24-9 

Name Fields Properly  

Acrobat looks at the text of the form to guess what fields should be called and it isn’t always right. If you see any 
fields that do not have useful names, double click them and rename as appropriate. 

 
FIGURE 24-10 
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ADD SAVE FUNCTIONALITY IN ACROBAT READER  

IMPORTANT – Unless you "distribute" the form as indicated below (which often times isn’t desirable), you must 
embed save rights (or "extend" save rights) into the PDF. If you do not, your users trying to fill out the form in 
Reader (like your clients, etc.) will receive this error: 

 
FIGURE 24-11 

To "extend" save rights, select File  Save As (XI) or Save as Other (DC)  Reader Extended PDF  Enable 
Additional Features. 

 
FIGURE 24-12 
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You will receive the following confirmation: 

 
FIGURE 24-13 

ADD A SUBMIT BUTTON TO YOUR FORM  

Your form can be distributed to recipients via email and the answers they supply to the form can be emailed back 
to you (rather than the form itself). Once you receive the answers, the form can be re-assembled and Acrobat will 
even store the information you receive in a database. To create the submit button, follow these steps: 

1. Add a new field. 

• Acrobat XI: Click Add New Field under Tasks (right side of screen)  Button. 

• Acrobat DC: Click on the Button button on the Prepare Form toolbar. 

 
FIGURE 24-14 

• Now position the button where you’d like and name it: 

 
FIGURE 24-15 
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2. Double click the button you’ve made and the Button Properties dialog will appear. On the Appearance tab, 
I’d recommend the following settings: 

 
FIGURE 24-16 

3. On the Options tab, give the button a Label. 

 
FIGURE 24-17 
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4. On the Actions tab, select the "Mouse Up" trigger, select the "Submit a form" action and click the Add 
button. 

 
FIGURE 24-18 

5. When you click Add, you’ll see the following dialog. In the top field, type mailto: and then your email 
address (no spaces). You might want to check the "convert dates to standard format" as well. If you want 
to make the incoming forms easy to deal with, then choose "PDF the complete document" below rather 
than "FDF Include" which is the default. 

 
FIGURE 24-19 

6. Now click the OK button, then the Close button at the bottom of the dialog. 

7. Click the Preview button on the Forms toolbar to see how your form will look. 
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DISTRIBUTE YOUR FORM  

Acrobat XI  

1. Click the Forms menu  Distribute Form. Now you’ll see the following dialog. Under "How do you want 
to collect…", choose "Manually collect…" and click the Next button. 

 
FIGURE 24-20 

2. Follow the subsequent on-screen instructions to distribute your form. When the forms come back via 
email, they’ll automatically compile themselves into a database Acrobat sets up for you. 

Acrobat DC  

1. Click the Distribute button at the bottom of the Prepare Form pane. 
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2. Choose email  Continue button. 

 
FIGURE 24-21 

3. Next, determine how you want to distribute the form. You can send it using Adobe Acrobat DC or save a 
local copy and manually send it later. 



THANK YOU!
ddavisroe@affinityconsulting.com


	TABLE OF CONTENTS
	1 Introduction
	PDF File Types
	PDF Files
	PDF/A?
	Image Only PDFs
	Searchable PDFs

	Why Use PDFs
	Acrobat Versions
	Microsoft Office Integration

	2 The Acrobat XI Interface
	Main Window
	Main Functionality of Each Section
	Customizing the Interface
	Quick Tools Toolbar
	Customizing the Task Pane
	Tool Sets


	3 The Acrobat DC Interface
	Home Screen
	Document Screen
	Dock the Floating Toolbar
	Selecting Text

	Tools Pane
	Navigation Pane
	Finding Functions in Acrobat DC

	4 Creating PDFs
	What Can Be Converted To A PDF
	Creating PDFs from Microsoft Office
	Acrobat Ribbon (Word)
	Export As PDF (Word, Excel and PowerPoint)
	Print Driver (Word, Outlook, Excel, and PowerPoint)
	Outlook Integration
	Creating PDFs from Individual Emails or Entire Folders
	Adding Subsequent Emails to Existing PDFs
	Automatic Archival

	Create PDFs Using Word Processor Functionality
	WordPerfect PDF Creation
	Word PDF Creation

	Create PDFs from Acrobat
	Acrobat XI
	Acrobat DC
	Web Page

	Creating PDFs from Scanners
	Scanners
	Basic Scanners Types
	Recommended Flatbed Scanners
	Recommended Sheet-Fed Scanners


	5 Viewing PDFs
	Read Mode
	Full Screen Mode
	Read Out Loud

	6 Creating a Text-Searchable PDF
	Convert an image-only PDF to Text-Searchable PDF
	Importance of ClearScan/Editable Text and Images
	Batch Processing to Text Searchable PDFs
	Acrobat XI
	Acrobat DC


	7 Copying Text Out of a PDF
	PDF Must Be Searchable to Copy Text
	Copy Text From a PDF and Insert into Word Processor
	Convert PDF to Word Processor Document
	Acrobat XI
	Acrobat DC


	8 Snapshot Tool
	Taking a Snapshot of a PDF
	Uses For This Feature

	9 Adding, Removing, & Replacing Pages
	Thumbnail View
	Adding Pages
	Adding Whole PDFs
	Moving Pages

	Task Pane
	ORGANIZE PAGES

	10 Combining PDFs
	Acrobat XI
	Acrobat DC
	Drag and Drop to Combine
	Create PDF From Files
	Combine from windows Folder

	11 PDF Portfolios
	Create a PDF Portfolio in Acrobat XI
	Create a PDF Portfolio in Acrobat DC

	12 Reducing PDF File Size
	Create Smaller PDF Files
	Print Driver
	Scanner

	Compress Existing PDF
	Acrobat XI
	Acrobat DC


	13 Splitting A PDF
	Determine the Size of Your PDF
	Split PDF
	Acrobat XI
	Acrobat DC


	14 Adding Comments and Markup to PDFs
	TypeWriter Tool
	Acrobat XI
	Acrobat DC

	Comments
	Acrobat XI
	Acrobat DC

	Other Annotations
	Attach files
	Printing Annotations
	Printing Document Options
	Printing Comment Summaries

	Show or Hide Annotations
	Collaborating on Markup

	15 Routing PDFs for Review by Others
	Choose a Review Type
	Email Based Reviews
	Shared Reviews
	Browser Based Reviews
	Send By Email For Review

	Merge Comments
	Compare PDFs

	16 Adobe E-Sign
	Send documents for E-signatures
	From Acrobat DC
	From Document Cloud

	Managing Documents Sent for Signature
	From Acrobat DC
	From Document Cloud


	17 Electronic "Image" Stamp Signatures
	Create The Stamp
	Steps for Using a JPG File
	Steps for Using a PNG File


	18 Bookmarks and Links
	Create Bookmarks
	Customize Bookmarks
	Change the Order of Bookmarks
	Nest Bookmarks
	Change the Format of the Bookmark Link
	Show Bookmark Panel When Opening PDF
	Other Controls for the Initial View

	Create Links to Bookmarks

	19 Watermarks
	Create a new Watermark

	20 Flattening PDFs
	Print to PDF
	Acrobat XI PRofessional: Flattening Fields Only

	21 Redaction
	Importance of Proper Redaction
	Redaction Steps
	Step 1: Save a Copy First
	Step 2: Open the Redaction Toolbar
	Set 3: Set the Redaction Properties
	Step 4: Mark for Redaction
	Manually Redact Text and Images
	Search and Redact
	Redact Whole Pages

	Step 5: Apply Redactions

	Using Comments and Redaction Summary

	22 Security for PDF Files
	Encrypt With Password
	Acrobat XI
	Acrobat DC

	Set A Document Open Password
	Restrict Permissions
	Choose Compatibility
	Security Envelopes:

	23 Eliminating PDF Hidden Content
	Acrobat XI
	Acrobat DC

	24 Fillable PDF Forms
	Drafting the Background Form
	Run Form Field Recognition
	Acrobat XI
	Acrobat DC

	Clean Up The Form
	Fix Check Boxes
	Fix Tab Order
	Format Fields Properly
	Name Fields Properly

	Add Save functionality in Acrobat Reader
	Add A Submit Button To Your Form
	Distribute Your Form
	Acrobat XI
	Acrobat DC


	25 Bates Numbering
	Add Bates Numbering
	AVOID OVERWRITING DOCUMENT GRAPHICS




